
TN008

Technical Note

DIRAC STIMULI

www.acoustics-engineering.com January 2008



Technical Note www.acoustics-engineering.com

TN008 Dirac Stimuli

This page intentionally left blank.

Copyright  2008 Acoustics Engineering January 2008 2



Technical Note www.acoustics-engineering.com

TN008 Dirac Stimuli

Table of Contents
1  Introduction.....................................................................................................5
2  Basic stimuli.....................................................................................................5

2.1  MLS..............................................................................................................................5
2.2  Sweep............................................................................................................................6

3  Filters................................................................................................................7
3.1  Pink + Blue filters.......................................................................................................8
3.2  Speech filters...............................................................................................................8

4  External stimuli...............................................................................................9
5  Using the stimuli on the Dirac CD...............................................................10

5.1  WAVE files................................................................................................................11
5.2  MP3 files....................................................................................................................13

6  References......................................................................................................13

Copyright  2008 Acoustics Engineering January 2008 3



Technical Note www.acoustics-engineering.com

TN008 Dirac Stimuli

This page intentionally left blank.

Copyright  2008 Acoustics Engineering January 2008 4



Technical Note www.acoustics-engineering.com

TN008 Dirac Stimuli

1 Introduction
Dirac provides many internally generated stimuli for different measurement situations. The 
Acoustics Engineering website, and the Dirac product CD contain a number of stimuli  in 
different formats that can be used effectively in open loop measurements.

This technical note describes the available stimuli. 

2 Basic stimuli
The basic stimuli that Dirac generates internally are the Maximum Length Sequence (MLS), 
and the sweep. The different stimuli can be selected in the measurement dialog.

2.1 MLS
The MLS [1][2] is a pseudo random binary sequence having a flat frequency spectrum. MLS 
stimuli  have been popular in impulse response measurement  systems because they can be 
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Fig 1: Dirac Measurement dialog - Stimulus selection
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generated using a simple shift register, and because deconvolving the response to an MLS 
stimulus can be performed very quickly using a cross correlation based on the Hadamard 
Transform.

An MLS signal is rather sensitive to system nonlinearities and time-variance. These effects 
cause  spikes  or  noise  that  are  distributed  over  the  full  length  of  the  response,  but  are 
particularly visible in the impulse response tail, and reduce the INR [6] or the IR decay range.

2.2 Sweep
The sweep  [3] consists of a sine wave that slowly changes over time from the lower to the 
upper edge of the spectrum. The sweep is less sensitive to time-variance, but sounds more 
intrusive.

There are two sweep variants  in Dirac: the linear sweep (lin-sweep), where the frequency 
increases  linearly  over  time,  and  the  exponential  sweep  (e-sweep),  where  the  frequency 
increases exponentially over time. Note that the e-sweep is sometimes referred to as a log-
sweep in the literature.

The linear  sweep is comparable  with the MLS in the sense that it  also has a flat  (white) 
frequency spectrum. The e-sweep has a pink (1/f) spectrum, and therefore has equal energy in 
each octave band. This property of the e-sweep is useful in the many situations where it is 
difficult to get a good signal to noise ratio at lower frequencies. The e-sweep also has the 
property that noise caused by system non-linearities or time-variance, can easily be separated 
from the actual impuls response.

Bandlimiting
With MLS signals, all the energy is spread evenly over the full spectrum for the duration of 
the stimulus. This in contrast with sweep signals where all energy is concentrated at a single 
frequency  for  each  moment  in  time.  This  concentrated  energy  can  cause  problems  for 
speakers at very low frequencies and at  very high frequencies.  To prevent damage to the 
sound source, it is possible to use bandlimited sweeps that only excite frequencies relevant for 
the measurement of acoustical parameters.

In Dirac the bandlimited sweeps can be enabled in the Options dialog on the Measurements 
tab:
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3 Filters
The basic stimuli described above can be filtered to handle specific measurement situations. 
The available filters can be selected in the Measurement dialog.
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Fig 2: Options dialog - Sweep bandlimiting
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3.1 Pink + Blue filters
In some measurement situations it is difficult to reach acceptable INR values in the lower 
frequency bands.  This may for instance be due to  higher  background noise levels  at  low 
frequencies,  or  due  to  a  lower  output  level  from the  sound  source  at  these  frequencies. 
Increasing the power output in the low frequency bands can help alleviate the problem. The e-
sweep stimulus has a 1/f spectrum that can be used effectively in these situations. The flat 
MLS or sweep stimuli spectra can be shaped to 1/f by the pink filter. To compensate for the 
pink filter, a blue filter is used on the recorded signal before the deconvolution calculations. 
The Pink+Blue filters are only available for the MLS and lin-sweep stimuli.

3.2 Speech filters
For speech intelligibility measurements [5] where the actual background noise is relevant, it is 
necessary to use test signals that have a prescribed (speech-like) spectrum. For this purpose, 
Dirac has female and male speech filters for STI and STITEL measurements, and a RASTI 
filter  for  RASTI  measurements.  These  filters  will  shape  the  (initially  flat)  spectrum of  a 
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Fig 3: Measurement dialog - Filter selection
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stimulus to conform to the requirements set out in IEC 60268-16  [4]. Note that the speech 
filters are only available for the MLS and lin-sweep stimuli.

4 External stimuli
The  internal  stimuli  generated  by  Dirac  are  normally  fed  to  a  sound  source,  while  a 
microphone connected to the PC is used to record the response.

In some situations it is very inconvenient or even impossible to have a direct connection from 
a PC to both the sound source and the microphone(s), for instance when the stimulus has to be 
fed into an existing PA system. For these situations Dirac allows the use of external stimuli 
being played from a CD- or MP3-player.

The MLS or sweep signals that are played by the external source must match exactly the 
stimuli generated by Dirac. Therefore the basic stimuli have been included on the Dirac CD as 
PCM data files (.wav files) and compressed MP3 files. 
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Fig 4: Closed loop measurement

Fig 5: Open loop measurement
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Impulse and noise stimuli
In addition to the basic stimuli (MLS and sweep), two other external stimuli can be used with 
Dirac.  
An external impulse can be generated with an alarm gun or a balloon. The recording of the 
external  impulse  immediately  gives  the  room's  impulse  response,  and  no  deconvolution 
calculations are performed. The reproducibility of external impulses is usually not very good.

In  external  noise  measurements,  a  noise  signal  is  fed  to  both  the  sound  source  and  the 
receiver. Dirac deconvolves the noise signal with the measured room response to recover the 
impulse response. The external noise method is of course not an open loop measurement as a 
connection from the PC to the sound source is still required.

5 Using the stimuli on the Dirac CD
The Dirac product CD contains a variety of files in the  stimuli folder and its sub folders. 
These files can be used to create an audio CD, or can be copied directly to a playback device 
such as an MP3 player.

It is important to setup Dirac correctly when using these external stimuli. In particular, the 
following settings must correspond to the properties of the external stimulus:

● Basic stimulus (e.g. MLS, lin-sweep or e-sweep)

● Sequence length

● Sample rate

● Bandlimiting option (for sweeps only)

When either of these settings is not correct, the resulting impulse response will be unusable.
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Fig 6: External noise and impulse measurements
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5.1 WAVE files
The MLS stimuli are all contained in the folder Stimuli\Allpass\MLS. They consist of a single 
sequence with a 48 kHz sample rate. The length of the sequence is encoded in the filename; 
the file named  MLSnn.wav has a length of 2^nn samples.  For instance MLS17.wav has a 
length of 2^17 = 131072 samples. At 48 kHz this is 2^17/48000 = 2.7 seconds.

To use this sequence on a CD, you will first have to change the sample rate to 44.1 kHz, 
which you can do using the following procedure:

1. Open the required sequence (MLSnn.wav) in Dirac.

2. From the File menu select Change Sample Format...
3. Change the Sample rate to 44100 Hz.

4. Make sure the Resample option remains unchecked.

5. Click OK and save the file.

Each  sweep  stimulus  is  contained  on  the  Dirac  product  CD  in  4  different  variants  as 
determined by the bandlimiting option (Stimuli\Allpass\ vs. Stimuli\Bandlimited\), sweep type 
(esweep vs lsweep), and sample rate (44 vs. 48). Note that you cannot change the sample rate 
of the sweep sequences (as described above for the MLS), because the sweep start- and end-
frequencies are dependent on the sample rate.

Because starting a measurement at the exact moment the playback of a sequence starts is 
practically impossible, it is necessary to concatenate the sequence a number of times. Also, a 
deconvolution based measurement requires the sequence to be played back at least twice. The 
first  sequence  to  build  up  a  steady  state  soundfield,  followed  by  a  sequence  for  the 
measurement.  If  averaging  is  to  be used,  the number  of sequences  needs  to  be increased 
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Fig 7: Changing the sample rate
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correspondingly.  You  can  use  most  sound  editing  software  to  concatenate  a  number  of 
sequences in a single .wav file. You can of course also use Dirac as follows:

1. Open the required sequence in Dirac.

2. Press  Ctrl-A to select the entire sequence, and  Ctrl-C to copy the sequence to the 
clipboard. Alternatively, use the Edit menu to Select and Copy the sequence.

3. Click  on  the  first  sample  in  the  impulse  response  window.  The status  bar  of  this 
window should now display a position and length of 0.

If selecting the correct insertion point using the mouse proves too difficult, you can 
choose Select... from the Edit menu and fill the dialog as depicted below:
 

4. Press  Ctrl-V (or  select  Paste on  the  Edit menu)  to  insert  the  sequence  from the 
clipboard.

5. Repeat steps 3 and 4 until the required number of sequences have been concatenated, 
and save the file.

When  saving  .wav  files  Dirac  adds  specific  information  to  the  file  describing  the 
measurement setup. This information can be seen and changed in the File Properties dialog 
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Fig 8: Insert position

Fig 9: Select
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in Dirac. Some programs (such as Windows Explorer) will not accept these .wav files when 
creating an audio CD. To remove the extra information from the .wav files, you can select the 
alternate .wav format from the 'Save as type' dropdown in the 'Save As' dialog:

 

Dirac will not write the extra information, and the resulting file(s) can be used by Windows 
Explorer to create an audio CD.

Note that you cannot write a single sequence to a CD, and then have the CD player repeat this 
sequence.  The  CD  player  will  leave  gaps  between  the  sequences,  which  will  ruin  the 
measurement.

5.2 MP3 files
MP3 players have a number of advantages over CD players for field measurements. These are 
the same reasons that have made the MP3 player the most popular digital media player. The 
Dirac product CD contains a number of MP3 files that can be used with any MP3 player. 

All MP3 files consist of a sequence that is repeated for 10 minutes. At the end of the file there 
is a 10 second pause to prevent an unnoticed automatic repeat by the MP3 player. The MP3 
files were encoded at a constant bit rate of 160 kBit/s using the Lame encoder. The sequences 
used to create the MP3 files have a sample rate of 44100 Hz.

The basic MLS and (bandlimited) sweep sequences are contained in the folder Stimuli\MP3. 
The length of the basic sequence is part of the filename. For instance: 'ESWP 12s.mp3'  is 
based on an e-sweep sequence with a duration of 12 seconds.

The folder Stimuli\MP3\Speech contains speech filtered MLS and lin-sweep sequences that 
can  be  used for  speech intelligibility  measurements.  For  more  information  on  the  use  of 
speech filters for speech intelligibility measurements, refer to the Dirac help file.
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Acoustics Engineering develops  systems  for  the  prediction  and  measurement  of 
acoustical  parameters,  resulting in user-friendly tools that  enable  you to  perform fast  and 
accurate acoustical measurements and calculations. 

For information on our products, please contact

Acoustics Engineering Email: info@acoustics-engineering.com

Phone/Fax: +31 485 520996

Mail: Acoustics Engineering
Groenling 43-45
5831 MZ Boxmeer
The Netherlands

Website: www.acoustics-engineering.com

Brüel & Kjær is the sole worldwide distributor of Dirac. For information on Dirac, please 
contact your local B&K representative or the B&K headquarters in Denmark:

Brüel & Kjær Email: info@bksv.com

Phone: +45 45 80 05 00
Fax: +45 45 80 14 05

Mail: Brüel & Kjær A/S
Skodsborgvej 307
DK-2850 Nærum
Denmark

Website: www.bksv.com
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